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Chapter 529

Two-Sample T-Tests
for Equivalence
Allowing Unequal
Variance
Introduction
This procedure allows you to study the power and sample size of equivalence tests of the means of two independent
groups using the two-sample unequal-variance t-test. Schuirmann’s (1987) two one-sided tests (TOST) approach is
used to test equivalence. Only a brief introduction to the subject will be given here. For a comprehensive
discussion, refer to Chow and Liu (1999).
Measurements are made on individuals that have been randomly assigned to one of two groups. This parallelgroups design may be analyzed by a TOST equivalence test to show that the means of the two groups do not
differ by more than a small amount, called the margin of equivalence.
The definition of equivalence has been refined in recent years using the concepts of prescribability and
switchability. Prescribability refers to ability of a physician to prescribe either of two drugs at the beginning of
the treatment. However, once prescribed, no other drug can be substituted for it. Switchability refers to the ability
of a patient to switch from one drug to another during treatment without adverse effects. Prescribability is
associated with equivalence of location and variability. Switchability is associated with the concept of individual
equivalence. This procedure analyzes average equivalence. Thus, it partially analyzes prescribability. It does not
address equivalence of variability or switchability.

Parallel-Group Design
In a parallel-group design, subjects are assigned at random to either of two groups. Group 1 is the treatment group
and group 2 is the reference group.
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Outline of an Equivalence Test
PASS follows the two one-sided tests approach described by Schuirmann (1987) and Phillips (1990). Let 𝜇𝜇1 = 𝜇𝜇𝑇𝑇
be the test group mean, 𝜇𝜇2 = 𝜇𝜇𝑅𝑅 be the reference group mean, and 𝐸𝐸𝐿𝐿 and 𝐸𝐸𝑈𝑈 be the lower and upper bounds,
respectively, on 𝛿𝛿 = 𝜇𝜇1 − 𝜇𝜇2 = 𝜇𝜇𝑇𝑇 − 𝜇𝜇𝑅𝑅 that define the region of equivalence.
It will be convenient to adopt the following specialized notation for the discussion of these tests.

Parameter
𝜇𝜇1 or 𝜇𝜇𝑇𝑇

PASS Input/Output Interpretation
Not used
Mean of population 1. Population 1 is assumed to consist of those who
have received the new treatment.

𝜇𝜇2 or 𝜇𝜇𝑅𝑅

Not used

Mean of population 2. Population 2 is assumed to consist of those who
have received the reference treatment.

EL, EU

Lower and Upper Equivalence Limits. If the difference is between these
two limits, the new treatment is said to be equivalent to the reference.

𝛿𝛿

𝛿𝛿

Actual difference. This is the value of 𝜇𝜇1 − 𝜇𝜇2 , the difference between
the means. This is the value at which the power is calculated.

𝐸𝐸𝐿𝐿 , 𝐸𝐸𝑈𝑈

Note that the actual values of 𝜇𝜇1 and 𝜇𝜇2 are not needed. Only their difference is needed for power and sample size
calculations.
With 𝐸𝐸𝐿𝐿 < 0 and 𝐸𝐸𝑈𝑈 > 0, the null hypothesis of non-equivalence is
The alternative hypothesis of equivalence is

𝐻𝐻0 : 𝛿𝛿 ≤ 𝐸𝐸𝐿𝐿 or 𝛿𝛿 ≥ 𝐸𝐸𝑈𝑈 .
𝐻𝐻1 : 𝐸𝐸𝐿𝐿 < 𝛿𝛿 < 𝐸𝐸𝑈𝑈 .

Two-Sample Unequal-Variance T-Test (Welch’s T-Test) Statistics
This test assumes that the two groups of normally-distributed values have unequal variances. Based on the
unequal-variance t-statistic proposed in Welch (1938), the calculation of the two one-sided test statistics uses the
following equations.
𝑡𝑡𝐿𝐿∗ =

𝑡𝑡𝑈𝑈∗ =

where
𝑋𝑋�𝑘𝑘 =

(𝑋𝑋�1 − 𝑋𝑋�2 ) − 𝐸𝐸𝐿𝐿
𝑠𝑠𝑋𝑋∗�1 −𝑋𝑋�2

(𝑋𝑋�1 − 𝑋𝑋�2 ) − 𝐸𝐸𝑈𝑈
𝑠𝑠𝑋𝑋∗�1 −𝑋𝑋�2

𝑛𝑛𝑘𝑘
∑𝑖𝑖=1
𝑋𝑋𝑘𝑘𝑘𝑘
,
𝑛𝑛𝑘𝑘

𝑠𝑠𝑘𝑘 = ��
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�,
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𝑠𝑠12 𝑠𝑠22
𝑠𝑠𝑋𝑋∗�1 −𝑋𝑋�2 = � + ,
𝑛𝑛1 𝑛𝑛2
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𝑑𝑑𝑑𝑑 =

𝑠𝑠𝑋𝑋∗�1 −𝑋𝑋�2

4

.
𝑠𝑠14
𝑠𝑠24
+
𝑛𝑛12 (𝑛𝑛1 − 1) 𝑛𝑛22 (𝑛𝑛2 − 1)

The null hypothesis is rejected if 𝑡𝑡𝐿𝐿∗ and −𝑡𝑡𝑈𝑈∗ are both greater than or equal to 𝑡𝑡1−𝛼𝛼,𝑑𝑑𝑑𝑑 .

Power Calculation
When 𝜎𝜎1 ≠ 𝜎𝜎2 , the power of the unequal-variance equivalence t-test is calculated as
Pr�𝑡𝑡𝐿𝐿∗ ≥ 𝑡𝑡1−𝛼𝛼,𝑑𝑑𝑑𝑑 and 𝑡𝑡𝑈𝑈∗ ≤ −𝑡𝑡1−𝛼𝛼,𝑑𝑑𝑑𝑑 |𝜇𝜇1 , 𝜇𝜇2 , 𝜎𝜎1 , 𝜎𝜎2 �

where 𝑡𝑡𝐿𝐿∗ and 𝑡𝑡𝑈𝑈∗ are distributed as the bivariate, noncentral t distribution with noncentrality parameters ∆𝐿𝐿 and ∆𝑈𝑈
given by
∆𝐿𝐿 =
∆𝑈𝑈 =
and

𝑑𝑑𝑑𝑑 =

𝛿𝛿 − 𝐸𝐸𝐿𝐿
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha.
Select Power when you want to calculate the power of an experiment that has already been run.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
nonequivalent means when in fact the means are equivalent.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of nonequivalent means when in fact the means are nonequivalent.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.
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N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.
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•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
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Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size – Equivalence Limits
EU (Upper Equivalence Limit)
Enter one or more values for the upper limit of equivalence. If the actual difference is between EL and EU, the
new treatment is said to be equivalent to the standard. You may enter values in the range EU > 0 and EL < δ <
EU.
EL (Lower Equivalence Limit)
Enter one or more values for the lower limit of equivalence. If the actual difference is between EL and EU, the
new treatment is said to be equivalent to the standard. You may enter values in the range EL < 0 and EL < δ <
EU.
If you want symmetric limits around zero, enter “-Upper Limit” here. The program will set EL = -|EU|.

Effect Size – Mean Difference
δ (Actual Difference)
This is the actual difference between the treatment mean and the reference mean at which the power is calculated.
For equivalence tests, this value is often set to zero. You may enter values in the range EL < δ < EU.

Effect Size – Standard Deviations
σ1 (Standard Deviation of Group 1)
The standard deviation entered here is the assumed standard deviation for the Group 1 population. σ1 must be a
positive number.
When σ1 is not known, you must supply an estimate. Press the small 'σ' button to the right to obtain calculation
options for estimating the standard deviation.
σ2 (Standard Deviation of Group 2)
The standard deviation entered here is the assumed standard deviation for the Group 2 population. σ2 must be a
positive number.
When σ2 is not known, you must supply an estimate. Press the small 'σ' button to the right to obtain calculation
options for estimating the standard deviation.
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Example 1 – Finding Power
A parallel-group is to be used to compare influence of two drugs on diastolic blood pressure. The diastolic blood
pressure is known to be close to 96 mmHg with the reference drug and is thought to be 92 mmHg with the
experimental drug. Based on similar studies, the within-group standard deviation is set to 18mmHg for the
treatment group and 15mmHg for the reference group. Following FDA guidelines, the researchers want to show
that the diastolic blood pressure with the experimental drug is within 20% of the diastolic blood pressure with the
reference drug. Note that 20% of 96 is 19.2. They decide to calculate the power for a range of sample sizes
between 3 and 60. The significance level is 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Two-Sample T-Tests for Equivalence Allowing Unequal Variance procedure window by
expanding Means, then Two Independent Means, then clicking on Equivalence, and then clicking on TwoSample T-Tests for Equivalence Allowing Unequal Variance. You may then make the appropriate entries as
listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 3 5 8 10 15 20 30 40 50 60
EU (Upper Equivalence Limit) ................ 19.2
EL (Lower Equivalence Limit) ................. -Upper Limit
δ (Actual Difference) ............................... -4
σ1 (Standard Deviation of Group 1) ....... 18
σ2 (Standard Deviation of Group 2) ....... 15

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two One-Sided Unequal-Variance T-Tests ─────────────────────────────
δ = μ1 - μ2 = μT - μR
Hypotheses: H0: δ ≤ EL or δ ≥ EU vs. H1: EL < δ < EU

Power
0.10733
0.17783
0.40940
0.55247
0.77233
0.88100
0.96794
0.99238
0.99818
0.99959

N1
3
5
8
10
15
20
30
40
50
60

N2
3
5
8
10
15
20
30
40
50
60

N
6
10
16
20
30
40
60
80
100
120

Lower
Equiv
Limit
EL
-19.2
-19.2
-19.2
-19.2
-19.2
-19.2
-19.2
-19.2
-19.2
-19.2

Upper
Equiv
Limit
EU
19.2
19.2
19.2
19.2
19.2
19.2
19.2
19.2
19.2
19.2

δ
-4.0
-4.0
-4.0
-4.0
-4.0
-4.0
-4.0
-4.0
-4.0
-4.0

σ1
18.0
18.0
18.0
18.0
18.0
18.0
18.0
18.0
18.0
18.0

σ2
15.0
15.0
15.0
15.0
15.0
15.0
15.0
15.0
15.0
15.0

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N = N1 + N2 is the total sample size.
EL and EU are the lower and upper equivalence limits, respectively, and are the maximum allowable differences
that still result in equivalence.
δ = μ1 - μ2 = μT - μR is the difference between the treatment and reference means at which power and sample
size calculations are made.
σ1 and σ2 are the assumed population standard deviations for groups 1 and 2, respectively.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements ─────────────────────────────────────────────────────────
An equivalence test of means using two one-sided unequal-variance t-tests with sample sizes of
3 in the treatment group and 3 in the reference group achieves 11% power at a 5.0% significance
level when the the equivalence limits are -19.2 and 19.2, the actual difference between the
means is -4.0, and the standard deviations are 18.0 in group 1 and 15.0 in group 2.

This report shows the power for the indicated parameter configurations. Note that the desired 80% power occurs
for a per group sample size between 15 and 20.

Plot Section

This plot shows the power versus the sample size.
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Example 2 – Finding the Sample Size
Continuing with Example 1, the researchers want to know the exact sample size to achieve 80% power.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Two-Sample T-Tests for Equivalence Allowing Unequal Variance procedure window by
expanding Means, then Two Independent Means, then clicking on Equivalence, and then clicking on TwoSample T-Tests for Equivalence Allowing Unequal Variance. You may then make the appropriate entries as
listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
EU (Upper Equivalence Limit) ................ 19.2
EL (Lower Equivalence Limit) ................. -Upper Limit
δ (Actual Difference) ............................... -4
σ1 (Standard Deviation of Group 1) ....... 18
σ2 (Standard Deviation of Group 2) ....... 15

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two One-Sided Unequal-Variance T-Tests ─────────────────────────────
δ = μ1 - μ2 = μT - μR
Hypotheses: H0: δ ≤ EL or δ ≥ EU vs. H1: EL < δ < EU

Target
Power
0.80

Actual
Power
0.80027

N1
16

N2
16

N
32

Lower
Equiv
Limit
EL
-19.2

Upper
Equiv
Limit
EU
19.2

δ
-4.0

σ1
18.0

σ2
15.0

Alpha
0.050

This report shows the exact sample size required for 80% power.
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Example 3 – Validation of Sample Size using Simulation
Machin et al. (1997) page 107 present an example of determining the sample size for a parallel-group design in
which the reference mean is 96, the treatment mean is 94, the standard deviation is 8, the limits are plus or minus
5, the power is 80%, and the significance level is 0.05. They calculate the sample size to be 88 for an equalvariance test.
If we assume that the standard deviation of group 1 is 8 and the standard deviation of group 2 is 6 and use
Welch’s unequal-variance test, then the Equivalence Tests for Two Means (Simulation) procedure, which itself
has been validated, calculates a sample size of 70 in each group.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Two-Sample T-Tests for Equivalence Allowing Unequal Variance procedure window by
expanding Means, then Two Independent Means, then clicking on Equivalence, and then clicking on TwoSample T-Tests for Equivalence Allowing Unequal Variance. You may then make the appropriate entries as
listed below, or open Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
EU (Upper Equivalence Limit) ................ 5
EL (Lower Equivalence Limit) ................. -Upper Limit
δ (Actual Difference) ............................... -2
σ1 (Standard Deviation of Group 1) ....... 8
σ2 (Standard Deviation of Group 2) ....... 6

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two One-Sided Unequal-Variance T-Tests ─────────────────────────────
δ = μ1 - μ2 = μT - μR
Hypotheses: H0: δ ≤ EL or δ ≥ EU vs. H1: EL < δ < EU

Target
Power
0.80

Actual
Power
0.80456

N1
70

N2
70

N
140

Lower
Equiv
Limit
EL
-5.0

Upper
Equiv
Limit
EU
5.0

δ
-2.0

σ1
8.0

σ2
6.0

Alpha
0.050

PASS obtains a sample size of 70 which matches the simulation result exactly.
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